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Welcome to NiceMemMaster

The NiceMemMaster is software dedicated to preparing and downloading true type fonts and pic-
tures to the memory cards installed in the thermal printers. Fonts and pictures that are downloaded
to the memory card are treated as internal printer objects. This enables much faster printing,
because there is no need to transfer text or pictures to the printer at print time.

The application can:

o Add, edit and view data, prepared for download on memory cards.
o Check the available memory card space before downloading.
o Share the information about the contents of the memory card with the label designer.

o Print the downloaded data from the memory card.




Setting Up the Application

User Interface

Main Window
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Setting the Folder Permissions

Before you can use the application make sure you have the write access permissions to the fol-

lowing folders:

m The default folder for storing labels (Tools -> Options -> General -> Folders -> Labels)

m The folder where your operating system installs the printer drivers.
For Windows XP the printer folder is the following "C:\WINDOWS\sys-
tem32\spool\drivers\W32X86\3"

When you select fonts and graphics for download to the memory card, the application stores this
information in the .MMF files into both folders. If you forget to change the access permissions for
the folders, the application will prompt you for the necessary changes.

If you are using the application under Windows Vista, the application that performs the initial
installation will be hidden from you. You will still be prompted to allow the installation by the

UAC (User Account Control). You should accept this installation, so that Windows Vista can auto-
matically install memory cards.

Customizing the Software

To change the preferences of the application, do the following:
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1. Select Options command in the Tools menu.
The Options dialog box opens.

2. You can change the options regarding the default folders and test string.
To customize the menus and toolbars, do the following:

1. In the Tools menu, hover over Interface, and select Customize.
The Customize dialog box will open.

2. Make modifications to the settings.

3. Click on the OK button.

Note: You can also change the positions of the toolbars on-screen. Just drag them to the new pos-
ition.




Working with the Application

Creating Memory Card Configuration
File

Creating Memory Card Configuration File

Memory card configuration file stores the information, which objects are currently present on the
memory card. Each configuration file is linked to some thermal printer. When you are designing
label in the label designer, the memory card configuration file provides the information about down-
loaded objects. The label designer then knows which objects can be recalled from the memory
card.

To create new memory card configuration file, do the following:

1. Select the command Printer Selection in the Card menu.
The dialog box Select Printer opens.

Note: You can also click on the icon in the toolbox.

2. Select the printer from the list. Make sure to select the printer driver NiceLabel Printer
Driver.

3. Select the Memory card slot type from the list.

Note: The available card slot types change accordingly to the selected printer.

4. Select the command New from the Card menu.

Note: You can also click on the I:I icon in the toolbox.

5. Type the name of the memory card configuration file and click on the Save button.
The Card Setup dialog box opens.

6. Enter the description of the memory card (optional) and select the proper card size.
7. Click on the OK button.

You have created an empty memory card configuration file.

You can start selecting the fonts and pictures to be downloaded to the memory card.

Adding Objects to the Memory Card
Adding Fonts to the Memory Card

To add fonts to the memory card, do the following:




1. Create you memory card configuration file.

2. Select the command Add in the Fonts menu.
The Open dialog box opens.

3. Select the font you want to download.

4. Select the characters from the font.

Note: This step is not necessary for thermal printers, that can download the true type files to the
memory card.

5. Click on the OK button to close the Font Data dialog box.
You can preview the selected font in the preview area.

6. Repeat the steps from step 2 until 5 to select additional fonts.
7. Make sure the printer is connected to the computer.

8. Select the command Download All from the Card menu.
The fonts are downloaded to the printer and stored to the memory card. Y ou can use
them on your label.

Adding Pictures to the Memory Card

To add pictures to the memory card, do the following:

1. Create you memory card configuration file.

2. Select the command Add in the Pictures menu.
The Open dialog box opens.

3. Select the picture from the hard drive you want to download.
You can preview the selected picture in the preview area.

4. Repeat the steps from step 2 and 3 to select additional pictures.

5. Make sure the printer is connected to the computer.

6. Select the command Download All from the Card menu.
The pictures are downloaded to the printer and stored to the memory card. You can use
them on your label.

Selecting Characters for Download

If your printer does not support downloading of the whole font in the memory card, individual char-
acters are downloaded as pictures. Characters are downloaded in the selected point size.

Note: You can download characters from the whole font. But to save the space in the memory
card you can select only the characters that will really be used on the label.

To select the characters for downloading, do the following:

1. Create you memory card configuration file.

2. Select the command Add in the Fonts menu.
The Font dialog box opens.




3. Select the font you want to download.
Also select the font style and size.

Note: The font can be downloaded only in the selected point size. If you require different font
size as well, you will have to download the fonts again and select different point size.

4. Click on the OK button.
The Font Data dialog box displays with the information about the selected font.

5. Click on the Characters button.
The Select Characters dialog box appears where you can select the characters for

downloading.

Note: The Select Characters dialog box has two different outlooks, depending on the selected
printing. Click on the Related Topics button for more information about this step.

4. Click on the OK button to close the Select Characters dialog box.
5. Click on the OK button to close the Font Data dialog box.

Selecting Font for Download

To select the font for downloading, do the following:

1. Create you memory card configuration file.

2. Select the command Add in the Fonts menu.
The Font dialog box opens.

3. Select the font you want to download.
The Font Data dialog box will open.

Note: You can select the true type font file (.TTF) or the font in selected point size. The selec-
tion depends on the functionality of your thermal printer. Not all printers can download the true
type file to the memory card.

4. If you could not select the true type file (.TTF), click on the Select Characters dialog
box and select characters you want to download.
Click on the Related Topics button for more information about this step.

5. Click on the OK button to close the Select Characters dialog box.
6. Click on the OK button to close the Font Data dialog box.

Using Types of Character Selection

There are two types of character selections.

1. Support for multi-lingual Unicode characters.

2. No support for multi-lingual Unicode characters.

Note: The selection of the type is done automatically based on the functionality of your thermal
printer. Not all thermal printers can work with multi-lingual data.




The selected memory card slot also has the influence on the font download mode. The printer
might allow downloading the true type font files to the printer when one memory slot is used, but
not for some other memory slot.

FIRST TYPE

The dialog box is divided into four panes.

o Character sets: Choose among the character sets that are available in the true type font.
If you have Unicode font, there will be many available character sets. Only one character
set can be used at a time.

« Available characters: The list of characters from the selected character set is displayed
here. Select one or more characters to be downloaded. Use standard Windows selection
shortcuts.

o Information: More information about the selected character set and selected character is
available here.

o Character preview: Currently selected character is magnified in this pane so you can
look at it better.

When you have selected appropriate character set and chosen among the characters to be down-
loaded, click on the OK button to proceed.
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Select Character dialog box

SECOND TYPE

There are two list boxes with characters. You can move them from one to another using buttons in
between. In both list boxes there are three columns. In first there is character in selected font. In
second is ASCII representation and in third it is character number.
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Character selection dialog box

Available list box: In this list box are all characters that are available in selected font and are not
already selected.

Selected list box: All characters, which will be downloaded to printer, are in this list box.

Select group: Select the group from the combo box to automatically select a group of characters in
the list.

Note: Some printers do not support all characters. Unsupported characters are painted red. You
can still select them, but they will not be downloaded to the memory card.

Downloading Objects to the Memory
Card

Downloading Objects to the Memory Card

The defined objects can be downloaded each at a time, or all at the same time. It depends on the
selected thermal printer.

To download all objects to the memory card, do the following:

1. Select the Open command in the Card menu.

Note: You can also click on the button in the toolbox.

2. Select the memory card file that contains the objects you want to download to the
memory card and click on the Open button.

3. Make sure the printer is connected to the computer.

4. Select the command Download All in the Card menu.
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To selectively download objects to the memory card, do the following:

1.

Select the Open command in the Card menu.

Note: You can also click on the button in the toolbox.

2.

Select the memory card file that contains the objects you want to download to the
memory card and click on the Open button.

Make sure the printer is connected to the computer.

Select the object you want to download to the memory card (font or picture).

5. Select the command Download from the Fonts or Pictures menu.

The object is downloaded to the memory card.

Repeat the steps 4 and 5 for the other objects you want to download.

Removing Objects from the Memory
Card

Removing Objects from the Memory Card

Once the object have been downloaded to the memory card, you cannot selectively remove them
on all thermal printers. It depends on the printer.

If the printer does not support selective object removal, the only method is to format the memory
card and download again all the objects that you still need.

Do the following:

1.

Select the Open command in the Card menu.

Note: You can also click on the button in the toolbox.

2.

Select the memory card file that contains the objects you want to remove from the
memory card and click on the Open button.

Make sure the printer is connected to the computer.

Select the command Format in the Card menu.
The contents of the memory card will be erased.

Note: You can also click on the icon in the toolbox.

If the printer does support the selective object removal, do the following:

1.

Select the Open command in the Card menu.

Note: You can also click on the button in the toolbox.

-11 -




2. Select the memory card file that contains the objects you want to remove from the
memory card and click on the Open button.

3. Select the object you want to remove from the memory card (font or picture).

4. Select the command Delete from the Fonts or Pictures menu.
The object is removed from the list.

5. Repeat the steps 3 and 4 for the other objects you want to remove.

Using Toolbox

Using Toolbox

Use the toolbox to have quick access to shortcuts for the commands

If you do not see the toolbox, select the command Toolbox from the View menu. The toolbox will
display under the menus.

Note: You can change the position of the toolbox and dock to any other position.

These are the buttons in the toolbox:
Create new memory card.
Open existing memory card.

Select printer where you want to download
objects.

Display the information about the memory
card.

Format the memory card in the selected
memory slot.

5 7 B FEE

Reload the contents of the memory card. Send
all objects to the memory card.
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Technical Support

Online Support

You can find the latest builds, updates, workarounds for problems and Frequently Asked Questions
(FAQ) on the product web site.

For more information please refer to:

o Knowledge base: http:/kb.nicelabel.com

o NiceLabel Support: http:/www.nicelabel.com/support

o NicelLabel Tutorials: www.nicelabel.com/Learning-center/Tutorials

¢ NiceLabel Forums: forums.nicelabel.com
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